) GuidosToolbox 3.0, Revision 0 (64 bit) - Default data directory: C:\GuidosToolbox\data\

File General Tools Image An,

Normalized

Autostretch

Orniginal Image

Image Info

Please load an image via the menu

Divide b wels: s s medium 4500




Generic Geometric Image Object Analysis

2. Processing: Analysis

of image components:
SW-developer

5

Aim: Toolbox for a generic description of spatial pattern

GuidosToolbox (GTB)': interactive desktop application (macOS, Linux, MS-Windows)
GuidosToolbox Workbench (GWB)2: command-line Linux server application
Documentation®: detailed product sheets and extensive workshop material...

(1): https://forest.jrc.ec.europa.eu/en/activities/Ipa/gtb/ S
2 (2): https://forest.jrc.ec.europa.eu/en/activities/Ipa/gwb/ “ Eoxamlasion



https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/

GTB menu: 4 thematically grouped containers

File:
File management,
Batch-processing,
Change analysis...

(GTB Manual: https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox Manual.pdf)

General Tools:

Pre-processing,
generic image filters,

GIS software...

Image Analysis:
Dedicated thematic

image analysis tools...

& input
File General Tools Image Analysis Help
y Be—
Read Image S IBUTES
Save Image >
Batch Process SR AT
scale v
Change P = '
Exit ‘
'nom Mode

Input: categorical raster maps, land cover, habitat & resistance maps, binary masks...

&) input

File General Tools

==

Preprocessing

Convoelution
Equalization
Threshelding

Edge Enhance
Morphological

GIS Software
Switch Cursor

Undo

Image Analysis Help

&) input

File General Tools

> —

IMAGE/DISF
[] Nomalized

Autostretch

» Original Image

Image Analysis Help

Objects

Pattern
Network(MSPA)
Fragmentation

Distance

Restoration Planner

WA NSRS NS NP N

Help:

Program documentation,
GTB product sheets, GTB
workshop material, further
resources ...

&) input

File General Tools Image Analysis = Help

Intext

— - )
IMAGE/DISPLAY ATTRIBUTES B Socamening o
GTB Online >
[[] Normalized ez EARLIL Related Resources >
Greyscale
Bug Report
Adtostretch —————  AboutGTE

Output: thematic feature maps and statistics, Google Earth image overlays, ...

European
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https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox_Manual.pdf

Accounting: size class mapping and statistics...

(Product sheet: https://ies-ows.jrc.ec.europa.eu/gth/GTB/psheets/GTB-Objects-Accounting.pdf)

2) Resulting map and statistics

) accixt - O X
File

) input (Accounting: 8-conn. objects: 2850)
File General Tools Image Analysis Help
P— Ob. .
IMAGE/DISF s
Pattern
] Nomalized Network(MSPA)
Fragmentation
[ Autostretch Distance
| Original Image Restoration Planner
1) Define area size-classes||| msew [
I
) Accounting X
Please define the Base Settings and the Area Thresholds in pixels for up to 6 Area Classes. {.7-%
|Base Settings:  |[Foregr C ivity: |8 v‘ |Pixel R ion [m] |100| ‘ [ Reset || Save || Restore
Gowes: Class - [Cass 2 [Class 3. [Class & [Class 5: [Class 6. [ Cancel | [ Accept |
Piels: [| 1550  v|piels || >[250  v|piels |[>[1000 v|piels [ >[5000 v]pixels || >[10000 - |piels | 10000 | pixels>
Hectares: (> 50.0000 ha | |-> 250.000ha | |-> 1000.00 ha | |-> 5000.00 ha [{|[> 100000ha |[|[100000ha > |
Acres: ||/(-> 123552ac -> 617.763ac -> 2471.05ac -> 12355.3ac -> 247105ac 24710.5ac ->
:gdaHu: Pixel Size = (0. 0 1)
CORE(s) 3 n/a A
CORE(m) |n/a n/a
CORE{) |[n/a n/a
ISLET |n/a n/a
PERFOR |n/a n/a
EDGE |[n/a n/a
LOOP n/a n/a
BRIDGE |n/a n/a
BRANCH |n/a n/a
Background |n/a n/a
Missing |n/a \n/a
Opening |n/a n/a
CoreOpen |n/a n/a
BorderOpen |n/a n/a v
< >
4

Accounting
Parcellation

Contortion

X:781 Y:8 object ID: 2519, area: 12637

Divide

1000 4600

Core pigels: small -

mediurm

Accounting size classes result using:

input

Base settings: 8-connectivity, pixel resolution: 100 [m]

Conversion factor: pixel_to_hectare: 1.00000, pixel_to_acres: 2.47105

Size class 1: [1. 50] pixels; color: black
#Objects Arealpixels] % of all objects % of total FGarea
2668 19953 93.6140 46565848

Size class 2: [51, 250] pixels; color: red

#Objects Arealpixels] % of all objects % of total FGarea
129 13094 452632 3.0558473
Size class 3: [251, 1000] pixels:; color: yellow
#0Objects Arealpixels] % of all objects % of total FGarea
30 13867 1.05263 3.2362482

Size class 4: [1001, 5000] pixels; color: orange
#0Objects Arealpixels] % of all objects % of total FGarea
13 30322 0.456140 7.0764775

Size class 5: [5001, 10000] pixels; color: brown
HObjects Arealpixels] % of all objects % of total FGarea
3 21796 0.105263 5.08669598

Size class 6: [10001 -> ] pixels; color: green

#0Objects Arealpixels] % of all objects % of total FGarea
7 329458 0.245614 76.888142
Sum of all classes:
H#0Objects  Arealpixels] % of all objects % of total FGarea
2850 428450 100.000 100.00000
Median Patch Size: 5
Average Patch Size: 150.347
Standard Deviation: 4143.11

Three largest object |Ds and area[pixels]; color: pink
These 3 objects overlay objects listed above

1) 1 214811
2) 901 33508
3) 1662 26366

European
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https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Objects-Accounting.pdf

Pattern: from 2 up to 25 morphological feature classes...

(Product sheet: https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-Morphology.pdf)

SPA5: SPA3 + Core boundary types

1 [M Coherent [ Core
g [ CoreOpening
i g A
_izsfaiesdii [ SLF: Small & S H Bl Margin
SPA2: Coherent & SLF linear features SPA3: Habitat & holes in habitat
[ Core [l Core
[ CoreOpening [l CoreOpening
psssatt M Edge pamen { Il Edge
H (external border) [l Perforation
[l Perforation ; 1 [l Islet (fragment)
: (internal border) o -
Ty -
s | I Margin : [ Margin

SPAB: SPAS + isolated non-coré fragments

[ [ IMAGE/DISF

[] Nomalized

[ Autostretch

Original Image

File General Tools Image Analysis Help

Objects

Pattern
Network(MSPA)
Fragmentation
Distance

Restoration Planner

3] input (MSPA: 8_1_1_1, FG_area: 428490, iFG_area: 485606)

> -
> Morphological > SPA2 (SLF)
> Moving Window > SPA3
> 8 SPAS

SPAG
MSPA

s

image ko . Factor: T2 v

INPUT: binary map
[l Foreground: objects of interest

[[] Background: complementary area

MSPA foreground classes
- Core: interior area excluding perimeter

[l istet: disjoint and too small to contain Core

[ Loop: connected to the same Core area

[l Bridge: connected to different Core areas
[l Perforation: internal object perimeter

I Edge: external object perimeter

Branch: connected at one end to Edge,
Perforation, Bridge, or Loop.

MSPA background classes
D Background outside Foreground

D Border-Opening: along Edge
- Core-Opening: within Perforation
]

| MSPASETTINGS
FGConn || EdgeWidth || Transition || Intext
[8/4] [pixels] [On/Off] || [On/Off]
o
MSPA statistics
FG/data[%] | #/BGarea
CORE(s) 1161 A
~ CORE(m) | 7.83/33 (19
CORE{) [61.34/26.29 16

ISLET 326/1.40 (2429

PERFOR

217/093 423
EDGE |13.54/5.80 890
LOOP 0.60/026 541

MSPA Tiling

BRIDGE |142/061 765
| BRANCH [393/168 4685 o
Background | -/57.14 | 2319/571240 7 3 3
Missing | 0.03 51/270
X: 1667 Z :

Opening _[83.24 Integrity 2291/57116 | 311 Y:667 Value: 0 (byte) MSPA class: BACKGROUND |
Comtpen 3| -/ 0.5 i [Divide  MSPA<Core pixels: small < ITDDO pd | medium |4600 V| > large
BorderOpen | -/ 5.12 1574/51189 v

< >
“ European
Commission



https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-Morphology.pdf

Landscape Mosaic: heterogeneity and human impact...

(Product sheet: https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-LM.pdf)

Land cover map

» 3,

Heterogeneity in Agriculture/Natural/Developed

(at user-selected observation scale)

) cIc3class (LM, kdim=9)

File General Tools Image Analysis Help

IMAGE/DIGF,___ OPIects :
m———— Pattern Morphological S
[[] Nomalized Network(MSPA) Moving Window % LM
Fragmentation ’ ’ v P2
[ Autostretch Distance = 1 p22
Original Image Restoration Planner P23
Image lnfo Factor: [4x b - Shannon
SumD
MSPA SETTINGS
FGConn || EdgeWidth (| Transition || Intext
[8/4] [pixels] || [On/Off] || [On/Off]
%]
MSPA statistics
FG/data[%] | #/BGarea
CORE(s) n/a n/a A
CORE(m) [n/a n/a
CORE{) |n/a n/a
ISLET |n/a n/a
PERFOR |n/a n/a
EDGE |n/a n/a
LOOP |n/a n/a
BRIDGE |n/a n/a
BRANCH |n/a n/a
Background n/a n/a
Missing |n/a n/a
Opening |n/a n/a
CoreOpen |n/a n/a
BorderOpen |n/a n/a v
< >

Measure land cover composition:

0.1 0.2 0.3 04 05 0.6 0.7 0.8 09 1.0

More Agriculture ->
( more Blue )

m European
Commission


https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Pattern-LM.pdf

Network: importance of connectors and habitat patches...

< >

3] input: Connectivity Importance(Node_max=19.8548, Link_max=19.8660) X
File General Tools Image Analysis Help
e ———— Object > L S
[ IMAGE/DISF = it :
Pattern > kP - L
: 3 o o e S
] Nomalized Network(MSPA) > NW Components = e e
: 2 < A e
Fragmentation > NW Node/Link Importance PR L
7 ._-:\,é,l,. .
[ Autostretch Distance > NW Component Connectors LN TN
:".l-."-, - =
Original Image Restoration Planner > MSPA Coneforlnputs ) Sl
T Factor: [4x <z ? 0 s i N
1, - : B
-
| MSPASETTINGS £ :
- o~
FGConn || EdgeWidth || Transition || Intext 3 e
[8/4] [pixels] [On/Off] || [On/Off] o -
drine :
MSPA statistics o d =
ol :
> 5
FG/data[%] | #/BGarea L
3 - H L]
 CORE®) A T N
_ COREm) |n/a A S ks i i
CORE{) [n/a n/a B 5 ',‘"'
~ ISLET  |n/a n/a # 3 A
__PERFOR_|n/a na
77ED(757E77 n/a n/a
LOOP n/a n/a
_BRIDGE |2 n/a 3
_ BRANCH |n/a nia -”
Back d |n/a n/a B
- gﬁzg?un X:5 Y:110 background
Missing  |n/a n/a
> Qp_t_E_f_?ir]g__. e s Divide MSPA-Core pizels: small 1000 mediunm 4600 large
_ CoreOpen_|n/a nia
BorderOpen |n/a n/a v

Use MSPA to detect
habitat patches
and corridors

Conversion to Nodes & Links

Use graph theory to rank and
locate the most important
corridors and habitats in the
current network (highest priority
for protection/conservation)

dPCintra>0
dPCflux =0
dPCconnector =0

PC-PC

remove, k

dPC, =100-

dPCintra>0
dPCflux>0
dPCconnector > 0

dPCintra>0 /
dPCflux> 0

dPCconnector =0

European |
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Fragmentation: multiscale or custom analysis...

(Product sheet: https://ies-ows.jrc.ec.europa.eu/gth/GTB/psheets/GTB-Fragmentation-FADFOS.pdf)

) input (FOS 6-class: 81x81: 410,063 hectares/1013.28 acres) X
1) Set fragmentation-type, observation scale, etc. P _Generai oot [FEEFEEES) e
T Objects
[ IMAGE/DISF
%) Please set: PixelResolution [m] x square WindowSize = Observation Scale X — Pattern
Nomalized etwork(MSPA)
Settings for Fixed Observation Scale (FOS): Options Lot 3
[FOS Type [FGconn || PixelRes [m] ||[WinSize (Observation scale fhectares, acres] Defaut values [ Autostretch TS B
|25 vI |81 v| |410.063 ”1013_23 | @ Restoration Planner Contagion
FOS-APP 2dlass  l00)304569054901.-0.000304569054901) | == 4“* i | [ T ’ -
FOS-APP 5<lass b
[ MSPASETTINGS
2) Resulting map and statistics showing the degree of | || |EbetianTaston| et
o
fragmentation in 2-6 classes and for = ==
. . i;- R European I
various or custom observation scales. | Commission MSPA satsic
Fragmentation: FG/datal] | #/BGarea
CORE! Y
RS st - & X . Intact can((fsn)) n/a :/: :
file s B Interior oonEp e
n/a n/a
FOS: Fixed Observation Scale summary analysis forimage: A /3 e -3
C\Guidos Toolbox'data\input £ [] Dominant R = £ '
8conn FG: area, # patches, aps [pixels]: 428490, 2850, 150.34737 Transitional LOOP |n/a n/a
Fragmentation class at observation scale: 410.063 hectares/1013.28 aci BRIDGE |n/a n/a I i
{Pixel resolution: 25[m], Window size: 81x81) [] patchy BRANCH |n/a = ! : G
3 Back: n/a n(a - - 4 : -
i i M Rare b e ]
Transitional:  26.1248 Opening |n/a n/a ASPA Core el <mall ¢ 1000 v | . 4600 “lsis
inant: 369115 . Background — e - Divide MSEPA-Core pizels: small < medium large
Interior:  17.2522 BorderOpen |n/a n/a v
Intact:  0.0941 D No data e ! -
FAD_av: 61.7917 i . spec'ﬂc BG
< > - Non-frag. BG — _ \
https:/iforest.jrc.ec.europa.eu/ - European
8 activities/Ipa/gtb/ ~——  Commission



https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Fragmentation-FADFOS.pdf

Distance: spatial arrangement and compactness...

(Product sheet: https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Distance-Euclidean.pdf)

Distance [m]

[4500 - 5000]
(4000 - 4500]
[3500 - 4000]
(3000 - 3500]
[2500 - 3000]
[2000 - 2500]
[1500 - 2000]

| (1000 - 1500]

[500 - 1000]

[0 - 500]

| -[0 - 500]
-[500 - 1000]
-[1000 - 1500]
-[1500 - 2000]
-[2000 - 2500]
-[2500 - 3000]
-[3000 - 3500]
-[3500 - 4000]
-[4000 - 4500]
-[4500 - 5000]

3] input (Euclidean Distance, adb=-5.37248 adf=6.28138: tick Divide for new distance range settings; Intext for barplot)

File General Tools Image Analysis Help

X

e Obijects
IMAGE/DISF Je
e Pattern
[] Normalized Network(MSPA)
Fragmentation "
[ Autostretch [[* BT SR T
L it N N e 3
@ Restoration Planner > Influence Zones
| Image Info ‘ I Factor [& V| l Proximity -
| MSPASETTINGS o= X :
FGConn || EdgeWidth || Transition || Intext =
[8/4) [pixels] || [On/Off] || [On/Off] 4 O¢
g |l Yag |= £
i
> e o
MSPA statistics 2
ks
FG/datal%] | #/BGarea 5
CORE(s) n/a 7S k : e
CORE(m) n/a in/a p 25 - :
CORE{) |n/a in/a 7 ’ qb A - -
ISLET |n/a n/a ik ) | Ot
PERFOR |n/a n/a v A -
R [~ B -
EDGE |n/a n/a S & st =
LOOP  |n/a n/a b 3
BRIDGE |n/a n/a = Jv PR, |
BRANCH |n/a n/a D ‘
Back: In/a h F_ S ST ss, |
ground n/a ‘n/a TR =
Missing |n/a n/a l g : oreground: 1.00000
o e [IDivide  Distance range: small < 5 V|medm 20 v| >large
CoreOpen |n/a n/a
BorderOpen |n/a in/a v
< >

 Locate compact habitat

« Distance to habitat boundary

~_I| * Hypsometric curve summary
‘ |
" #) BarPlot — a X
Distance histogram (input)
. [T T T I T T T I T T T I T T T l_
tae 1x10° — -
5x10° [~ .dh = 537350 ]
" bgo = -1170 7]
i d_max = -35.9706 i
oy B R
g o 3
§ - adf = 6.28217 -
: fgo = 2850 ]
B5x10° — d_max = 39.1127 =
N B ]
Ax10° :— —:
N ] | l | I ; 1 1 I l | 1 L1
-40 -20 0 20 40
Background distance [pixels] Foreground
SHEXE® vl 41701
7 - - European
- Commission



https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-Distance-Euclidean.pdf

Restoration Planner: quantify network integrity; evaluate,
simulate or locate most efficient restoration scenarios...

(Product sheet: https://ies-ows.jrc.ec.europa.eu/gtbh/GTB/psheets/GTB-RestorationPlanner.pdf)

1) Network status summary.

Locate optlmum path between start and

habitat

#F) Restoration status summary, network of FG-objects (2b): — O X
Y. )
File P e g
7~ “S\ \ Opﬁmum Path -~ : -
AREA RAC[%] NR_OBJ LARG_OBJ APS CNOA ECA %) B S To_od™ i L - e - Lr
42849000 42860572 2850 214811 15034737 3712 22129276 i { * P =
1 S at 5
- gl R | At
Note: select File -> Save Image to save the restoration status summary. - &%, m’ b . ‘ D =
. . . . . 0 : ﬁ_;_ 5 7: ; 5‘; ’ .’ g
Coherence: spatial network integrity in % L o i t)‘ A :
R R il i X
o S g = : 1
. " 2 S i 5 e
2) Setup & luat torat ’; : = o N
etu evaluale restoration scenarios. . : L
s i -7 \j S -
B) input (Reconnect object: 1190 <-> 901, DELTA_COH: 10.981435% tick FGConn to reset) X ey S = ‘h s A e
File General Tools Image Analysis Help - _,“. ‘\1-
—————  Objec: > 5 (e % :
[Eic= > e €W, T | & FRIEE D E F G H [ K L
I Nomatzsd Network(MSPA) . e O 1 SIZE_A SIZE_B REST_PIX AVDIST_RP EXP_30 EFFIC ECA_ORIG ECA_NEW DELTA_ECA COH_ORIG COH_NEW DELTA_COH
o 5 %‘ | 2] 1as1 33508 65 1.80456 1950 24.151311 221292.76 268387.81 47095.056 51.644789 62.626224  10.981435
[Autostretch Distance > - LR
Original Image Restoration Planner > s=
Image Info o Status Summary
Int ti | d d | te tom restorati
T o s n eraC ive raW an eva ua e an custom restoration scenario
ustom Patl
FGConn (| EdgeWidth || Transition ||  Intext Find Optimum Path ~ 3 T
[874] || [pixels] || [On/Off] || On/Of] Show Optimum Big 5 P W'
c | o
4 Isochrone Map A ., & ;r" i
MSPA statistics ) - = Scchonetian 8 - o { |
CoRE) /8 & T T T el Custom Path result:
COREm) |n/a n/a i : N e s
EOREY) "f néa it . d Restore Pixels: 200
Flés?lz-gh :/: :: o - N DELTA_COH: 0.0729825%92
EDGE v na TRAR . EFFICIENCY: 0.069359776
Sl L -
L0oP |/ n/a e AVDIST_RP:  5.46738
BRIDGE |n/a n/a 5 :
_BRANCH |n/a n/a kS 7 tick FGeconn to reset
Background |n/a n/a >
Missing  |n/a n/a [X:g X:54: backopind l
c?:g:‘:f :Z :: Clowde  MSPACore pocls: smal < 1% ] ey 4690 10 oK.
BorderOpen |n/a n/a v
< >
Al [ B C ] E_| -F J
1 |REST_PIX AVDIST RP EXP 30 EFFIC ECA_ORIG ECA_NEW DELTA_ECA COH_ORIG COH_NEW DELTA_COH m European_
2 200 SA6738 6000 0.069359776 221292.76 221708.92 416.15865 S51.624789 51717772 0.072982592 CommISSIon



https://ies-ows.jrc.ec.europa.eu/gtb/GTB/psheets/GTB-RestorationPlanner.pdf

Change analysis, contortion, batch-processing, ...

(more details in the GTB Manual: https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox Manual.pdf)

Morphological change detection Export as Google Earth overlay:

File General Tools Image Analysis Help

&) MCD (A->B) FG: -7.37697, FGi: -12.0295, Elasticity: 1.63068 X MSPA In Rondonla BraZ” Pest riSk: influence Zones. .

Read Image >

RIBUTES Sty Google Earth - o e L1} s 0
SevElmage 2 File General Tools Image Analysis Hel
Lt Colortable [ Fdit fiew Jooks Add Help ile General Tools Image Analysis Help
Batch Process > f—— !‘» ey - v Soarch e ——
Change > FOS : } [ IMAGE/DISPLAY ATTRIBUTES
Exit FAD 122.107162 Direction/Data Select Colonable
Orginal Image || | LM heatmap GetDirectons. Hitory Fip Vertical | | Classfication /|
= s F: = v Places
 imegelo || [ 9 Simple Change = TG b P g : | ZoomMode |
Morph. Change ¢ 25 sahtiesing Teur [ Nomalized
[ MSPASETTIN  Restoration Change - Facor & v
FGConn || EdgeWidth || Transition || Intext | bnage Info
(874 [pixels] || [On/Off] || [On/Off] :
= = = MSPA SETTINGS
FGConn || EdgeWidth || Transition || Intext
/4] | Ipbeels] || [On/Off] || [On/Of]
MSPA statistics -
FG/data[®] | #/BGarea
CORE(s) a n/a ~ _
COREm) |n/a n/a MSPA statistics
COREf) |n/a n/a P aaia] | Freuen
ISLET _|n/a s COREfs)green |00 n/a A
| PERFOR "; a "‘j" CORE{m)areen |n/a n/a
EDGE |n/a n/a - e 1000 e 4600 i | COREf}green | n/a n/a
LOOP n/a n/a ivide M5PA-Core pisels: smal nedium arge |SLETbrown _|n/a ok
ERIDGESIn/a g PERFblue_ |n/a n/a
BRANCH |n/a n/a EDGEblack |n/a n/a
Background |n/a n/a F r I r
criria e LOOP+yellow |n/a n/a
Mssing In/a il | BRIDGEred |n/a n/a ‘
OvaEgl|a n7a . # 5@ Glohal Axareness BRANCH-orange |n/a n/a .
e pr Forest gain areas e ——
Backggrey |n/a it X867 Y: 482 infiuence zone: (ID: 29)
BorderOpen |n/a n/a v Miss-white  |n/a n/a v
< > < > [ Divide  Buffer zone: F "'|1 Vl Back 410 V‘

The GTB Product Sheets: -

———— Free download:| & 0 Toolbox fully portable directory: |

—1 Objects | IAccounting I I Parcellation I . f . “ 5\
B (e ] C\ g f.'ll] copy to & work from external drive! ) M
https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb!/ Customers: R ¢

—{ Fragmentation | [ FaD/FOS |
\l‘:} v E,-,-,‘zoa sansa
https://forest.jrc.ec.europa.eu/en/activities/Ipa/gwb/ Do e
GuidosToolbox workshops: https://forest.jrc.ec.europa.eu/en/activities/Ipa/gtb- workshops/ m European |
11 Contact: peter.vogt@ec.europa.eu Commission



https://ies-ows.jrc.ec.europa.eu/gtb/GTB/GuidosToolbox_Manual.pdf
https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/
https://forest.jrc.ec.europa.eu/en/activities/lpa/gwb/
https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb-workshops/
mailto:peter.vogt@ec.europa.eu?subject=GuidosToolbox%20question
https://forest.jrc.ec.europa.eu/en/activities/lpa/gtb/

Thank you
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